
AMDIS и работа с библиотеками для начинающих

Это – иллюстрированное руководство по работе с AMDIS и смежным вопросам. Возможно, оно 
настораживает своим размером. В действительности, он невелик, поскольку информативность 
каждого слайда (кроме некоторых, текстовых) мала из-за преобладания иллюстраций. 

Если Вы – начинающий пользователь, то настоятельно рекомендую просматривать руководство, 
сразу же пробуя повторить излагаемое в окнах AMDIS и NIST. Руки обязательно запомнят, и появится 
целостное восприятие.
Если Вам обсуждаемая тема известна и понятна, то Вы можете просто – по-быстрому – пролистать 
презентацию и, возможно, найдете что-либо интересное. 

Если появятся какие-либо вопросы (замечания, возражения, сомнения и пр.), то мои реквизиты 
таковы:
chrzond4250@yandex.ru (могу редко заглядывать в почту, поэтому короткая смс-ка ускорит процесс)
+7-(960)-629-94-61 (круглосуточный)

С уважением – Григорьев А.М. 

mailto:chrzond4250@yandex.ru


Содержание

3 - Примечания, аббревиатуры и сленг.
4 – Назначение и особенности AMDIS.
9 – Кратко об индексах удерживания.
11 – Начало работы с AMDIS.
13 – Поиск соединений по спектру (без учета удерживания) и общие приемы работы.
28 – Поиск соединений по спектру и индексу удерживания.
34 – Оформление отчета.
38 – Калибровка удерживания по алканам.
47 – ГХ-МС библиотеки.
48 – Комплект NIST.
56 – Поисковая библиотека AMDIS (формат .MSP).
63 – Специализированная алкановая библиотека (.CSL)



1. AMDIS сохраняет все настройки (кроме тех, которые относятся к индикации). При закрывании 
окна AMDIS и повторном ее вызове повторный же ввод настроек не требуется (если, конечно, 
программу не переустанавливали. Кстати, они хранятся в файле onsite.ini в каталоге AMDIS, и их 
можно корректировать вручную.).
2. Понятие «калибровка» в этой презентации имеет единственный смысл: это калибровка 
времен по индексам удерживания! (далее RI). К количественному анализу и калибровке 
сигналов детектора по количеству вещества это не имеет никакого отношения!
3. «Важно!» – та информация, на которую особенно рекомендую обратить внимание.
4. Рисунки в этой презентации не закреплены. Если что-то плохо видно, то просто сдвиньте (или 
растяните) рисунок. Потом, конечно, желательно вернуть на прежнее место…

TIC – общий ионный ток (и хроматограмма, отображаемая в данном режиме).
ГХ – газовый(ая) хроматограф(ия).
МС – масс-спектрометр (масс-спектр).
обзорник – программы обработки хроматограмм (Data Analysis для Agilent). 
ЛК – левая кнопка мыши.
ПК – правая кнопка мыши.
Натив (ксенобиотик) – исходное, т.е. не метаболизированное и не дериватизированное
соединение, попадающее в организм.

Примечания, аббревиатуры и сленг.



Зачем нужна AMDIS и почему не следует искать соединения обзорником.
1. Ион-хроматограммы – чрезвычайно емкий источник информации. А специфика нашей деятельности связана с биологическими 
образцами, которые – сами по себе – обладают богатой матрицей, причем искомого соединения в образце обычно очень 
немного. И потому каждый пик на хроматограмме TIC обычно не соответствует чистому веществу. Почти как правило, он 
представляет собой смесь соэлюирующихся соединений. И это так – несмотря на то, что капиллярные ГХ-колонки весьма 
эффективны. Можно добавить, что ГХ-МС система обладает собственным фоном: остаточные газы, всегда присутствующие в 
камере МС (компоненты воздуха – азот, кислород, вода, углекислота) плюс фон (или течь) самой ГХ колонки (пример на слайде 
19). Фон усиливается при повышении температуры, что хорошо видно на градиентных хроматограммах. Значит, щелкая по пикам 
в обзорнике можно получить лишь загрязненные спектры (исключение составляют нечастые случаи высокой концентрации –
однако, этот вариант более характерен для анализа вещественных доказательств, т.е. ФСКН или МВД, но не для нас). В результате, 
опознание вещества по спектру будет ненадежным или невозможным. Конечно, можно пытаться вычитать фон средствами 
обзорника, но такой способ пригоден лишь для постоянного (или линейно меняющегося) фона. А как же соэлюирование?

2. Исходя из п.1, можно не сомневаться в том, что ручная обработка ион-хроматограмм приведет лишь к многочисленным 
ложноотрицательным результатам. Да, в обзорнике есть поисковые функции, однако, их надо конфигурировать по каждому 
соединению. Сколько таких соединений можно занести вручную – 10, 100? Сколько времени это займет? И это будут скорее всего, 
нативы и/или их дериваты, но не метаболиты. А в профессиональных тематических поисковых библиотеках для AMDIS их тысячи 
(в известной библиотеке Maurer с соавт. – более 8500). Автоматическая обработка ион-хроматограммы занимает минуты.

3. К сожалению, масс-спектр не является абсолютно специфичной характеристикой вещества. Есть достаточно веществ с очень 
похожими, а есть – с весьма малохарактеристичными спектрами. Эта ситуация обычно усугубляется тем, что при малых 
концентрациях МС обеднен или искажен и надежное опознание, конечно же, невозможно. А значит, нужна дополнительная (и 
независимая от МС) характеристика вещества, и это, разумеется, удерживание. AMDIS работает и с параметрами удерживания.

4. Но – пользоваться просто временем удерживания – крайне неудобно. Ведь оно изменится при смене колонки (у них, вообще-
то, разная длина – трудно 30-метровой трубке и слою фазы в ней придать точные размеры, да ее еще и подрезают при установке 
в ГХ-МС). А также при обрезке начального участка после загрязнения, при старении и общем загрязнении. Значит, измерять 
удерживание надо в каких-то относительных величинах. Без дополнительной аргументации (хотя предоставлю ее при запросе), 
полагаю оптимальной систему алкановых индексов: кстати, ее возраст исчисляется десятилетиями, и это – сложившийся стандарт 
измерения удерживания в ГХ. AMDIS органично предназначена для работы с индексами, а один из результатов ее работы –
численная характеристика качества идентификации, основанная как на масс-спектре, так и на удерживании.

5. Для чего же тогда нужен обзорник? У него достаточно своих функций. Рассматривать хроматограммы, накладывать их, 
сравнивать, проводить количественный анализ и пр.



Чего не может делать AMDIS.
То, что описано в п. 5 на предыдущем слайде. 
1. В AMDIS загружается только одна хроматограмма, и это правильно. Вообще, AMDIS (теоретически) может работать с 
несколькими хроматограммами в отдельных окнах, но этот режим крайне ненадежен.
2. AMDIS вычисляет площади пиков, но эта функция, скорее, имеет подчиненный (дополнительный) смысл. В качестве интегратора 
использовать ее не надо.
3. Важно! Разумеется, AMDIS способна идентифицировать только те соединения, чьи характеристики указаны в применяемой 
поисковой библиотеке (просто иногда об этом забывают).

Что делает AMDIS.
Все процедуры описать не смогу; думаю, создатели AMDIS их (в полном объеме) тоже не знают/забыли. Но кратко:
1. Обнаруживает соединения на хроматограмме.
2. Получает очищенные масс-спектры для каждого соединения. Для этого существуют соответствующие математические 
процедуры (деконволюция).
3. Определяет индексы удерживания (если такая задача поставлена).
4. Идентифицирует найденные соединения на основании их очищенных спектров и индексов удерживания и характеризует 
качество идентификации.
5. При запросе – печатает отчет.

Почему именно AMDIS.
1. AMDIS – бесплатная программа, распространяемая американским национальным Институтом стандартов и поэтому прекрасно 
совместима с остальной продукцией NIST. И это – в ситуации, когда производители ГХ-МС оборудования увлечены конкурентной 
борьбой и поэтому не заинтересованы в совместимости.
2. По крайней мере, мне неизвестны какие-либо аналоги AMDIS. 
Не так давно меня попросили обратить внимание на некую возможную замену AMDIS: этот программный продукт  с (якобы) 
подобной функциональностью был опубликован на одном из англоязычных тематических сайтов Интернет.  Продукт оказался 
платным, и сайт предлагал оценить триальную (временную) версию. Экспертиза сего творения продолжалась недолго и привела к 
выводу о том, что его создателям предстоит длительный и упорный трудовой путь, в конце которого – может быть и когда-нибудь 
– они смогут хотя бы предложить испытать его результаты. Однако, эти люди хотели денег – и сразу.
Возможно, кто-либо действительно укажет на возможную замену AMDIS, и я буду рад ею воспользоваться. Но те люди – за сайтом 
– скорее, были похожи на мошенников.
3. Некоторые алгоритмы AMDIS реализованы в последних версиях аджилентовского пакета MassHunter (так указано в описании). К 
сожалению, знакомство с этой реализацией только подпортило настроение: она крайне неудобна и нетороплива.
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Как AMDIS обнаруживает соединения на хроматограмме.
Допустим, что имеется хроматограмма, зарегистрированная в режиме SCAN в обычном диапазоне – например, от 45 до 600 m/z. 
Это значит, что в действительности масс-спектрометр регистрировал 556 независимых ион-хроматограмм (600 – 45 + 1 = 556). Их 
сумма (по ординате) – это еще одна хроматограмма (TIC).
AMDIS просматривает каждую ионную хроматограмму и ищет хроматографические пики на ней. Каждый пик интегрируется: 
определяются времена его начала, конца и максимума.
Рассмотрим пример (пять ион-хроматограмм и их сумма – TIC). Допустим (для упрощения) что все остальные ион-хроматограммы
пусты.
Пики 1 и 2 образованы, вроде бы, только одним ионом – 73. Однако – если приглядеться – то на хроматограммах 149 и 275 видны 
небольшие горбики, близкие по удерживанию к пикам на хроматограмме 73. AMDIS придется вынести решение, считать ли эти 
«горбики» пиками или шумом . В первом случае масс-спектры веществ 1 и 2 будут состоять из интенсивного иона m/z 73 и 
малоинтенсивных  149 и 275, во втором - только из одного иона (73). Для вынесения такого решения AMDIS оценит уровень шумов 
для каждой ион-хроматограммы.
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Как AMDIS обнаруживает соединения на хроматограмме (продолжение).
Пик 4 имеет почти одинаковое время максимума на ион-хроматограммах m/z 73 и 383. А что значит «почти»? Вот здесь AMDIS придется 
принять решение о том, считать эти пики принадлежащим одному веществу, или нет. Такое решение будет принято на основании ряда
математических алгоритмов обработки – и, разумеется, настроек AMDIS. Смена настроек приведет к разным решениям, и какое 
решение наиболее правдоподобно – решать оператору. Об этом далее.
Пик 5 почти не виден на хроматограмме TIC, но отчетлив на 383. Скорее всего, его спектр будет состоять из одного иона – 373.
А вот следующий пик на хроматограмме TIC образован, как минимум, двумя соединениями - 6 и 7, причем это видно только на ионных 
хроматограммах (но не на TIC). Это – соэлюирование. Наверное, соединение 6 характеризуется только ионом  149 (кстати, это фталат), а 
соединение 7 – уже тремя (73, 193, 275), и его спектр будет состоять из этих трех ионов. В данном случае AMDIS примет верное решение 
о наличии двух веществ и отобразит их чистые масс-спектры. А если времена максимумов пиков 6 и 7 будут еще ближе, или даже 
совпадут? Тогда AMDIS может посчитать их одним веществом (с масс-спектром, содержащим все ионы – 149, 73, 193, 275), и это, 
разумеется, будет ошибкой. Устранить такую ошибку математическими приемами невозможно, поскольку сами исходные 
хроматограммы – в случае совпадения - не содержат никакой информации о наличии именно двух соединений. Образец придется 
перекалывать в других условиях – ускоряя или замедляя градиент, или же меняя хроматографическую фазу.
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Как AMDIS обнаруживает соединения на хроматограмме (окончание).
Пик 8 образован ионами 275 и 73. Однако, пик на ион-хроматограмме 73 (кстати, все это – хроматограммы триметилсилилированного
образца, а ион m/z 73 обычен для спектров TMS-дериватов, и следовательно, не характеристичен) является наездником пика вещества 
7. Попадет ли он в масс-спектр вещества 8, определяется настройками. Иногда решение о принадлежности таких ионов найденному 
веществу проще принять самостоятельно, разглядывая ион-хроматограммы. Как правило, при этом отпадают вопросы о том, почему 
какой-либо ион попал в спектр – или же почему его там нет.
Пики со знаком вопроса (3, 9, 10), очевидно, образованы соэлюирующимися соединениями. Это видно по их форме на TIC и m/z 73. 
Ионы, которые их образовали, на этой картинке отсутствуют. 
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Кратко об индексах удерживания.

Алкановый индекс – «всего лишь» выражение удерживания соединений относительно удерживания нормальных (неразветвленных) 
алканов. Значит, чтобы измерять удерживание в шкале индексов (RI), надо знать времена удерживания алканов. А AMDIS придется 
составить пересчетную таблицу.
Каждому алкану приписывается индекс, точно равный произведению числа метиленовых групп на 100. Так, для декана он 1000 (у 
декана – 10 метиленовых групп), для пентадекана (С15Н32) – 1500, и.т.д. 
AMDIS рассчитывает линейный индекс , не учитывающий мертвый объем колонки и не соответствующий классическому 
(логарифмическому) индексу Ковача. Это объясняется неудобством использования индекса Ковача в режиме градиентной ГХ (он 
формулировался для изократики). Однако – в численном плане – эти величины довольно близки.
AMDIS пользуется простейшей (кусочно-ломаной) аппроксимацией, т.е. полагает, что индекс меняется линейно при переходе от 
одного алкана к другому. И соответствующие вычисления просты, например:
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У алкана С28 (индекс 2800) удерживание 10 мин. 
У С30 (индекс 3000) – 11 мин.
Значит, если у некоего интересующего нас вещества «Х» 
удерживание 10.5 мин, то его линейный индекс равен 2900. 
Для измерения индекса удерживания любого соединения 
необходимо, чтобы его удерживание (мин) находилось 
между удерживанием двух алканов.

Для корректного измерения индексов есть два требования. 
1. Не следует пытаться измерить индекс вещества, 
удерживание которого меньше (больше) имеющегося  
алканового ряда. Да, AMDIS его все равно рассчитает, но 
полученная величина будет неверной.
2. Крайне желательно брать смежные (по числу метиленов) 
алканы. Если они взяты с большой разницей между числами 
метиленовых звеньев (например, С20 и С30 вместо хотя бы 
четного ряда С20, С22, С24, …, С30), то индекс будет измерен  
с недопустимо большой погрешностью. 



Кратко об индексах удерживания (окончание).

Некоторые особенности поведения индексов.

1. Для разных хроматографических фаз индексы, разумеется, различны, поскольку различна их селективность. Чем полярнее фаза, 
тем больше индекс. Например, на распространенных слабополярных фазах, аналогичных 5% фенилметилполисилоксан (это HP-5ms, 
DB-5ms, Rtx-5ms и многие другие), индекс удерживания кодеина около 2416 (то есть, он выходит после алкана С24 и перед С25) . А на 
среднеполярной DB-17ms (аналогичной 50% фенилметилсилоксан) его значение около 3028. Кстати, поэтому колонка DB-17ms удобна 
для подтверждающих определений.

2. На каждой фазе индекс немного меняется при изменении температурных условий разделения. Если увеличивать температуру (или 
делать более крутым градиент), то индекс растет. Например, для того же кодеина (фаза HP-5ms):
градиент 100-300°С, скорость 35°/мин – около 2416;
градиент 100-280°С, скорость 15°/мин – около 2472 (кстати, в этом примере представлено весьма значительное изменение условий).
Чем соединение более полярно, тем сильнее его индекс меняется с температурой. Для TMS-дериватов это изменение обычно 
невелико.
Поэтому, строго говоря, надо пользоваться индексами, измеренными в тех условиях, которые приняты как рабочие. Однако, если это 
невозможно, то серьезных затруднений все равно нет. При первом обнаружении вещества с помощью AMDIS и поисковой 
библиотеки с индексами можно  пользоваться приблизительным значением, приведенным в этой библиотеке (разумеется, при 
условии надежного совпадения МС и при отсутствии сомнений в наличии этого вещества). И затем - откорректировать его значение. 
Альтернатива №1 – пользоваться тем методом и той колонкой, для которых и была сформирована библиотека. Это – неудобно.
Альтернатива №2 – не выдавать заключений без прокола стандартного вещества. Это – нереально.
Альтернативу №3 – обойтись без учета удерживания – я не оцениваю вообще. Хотя, AMDIS вполне используема и в таком режиме.

3. Кроме индексов удерживания, в последнее время применяется еще один режим – учет удерживания с помощью фиксации времен 
(ФВУ – фиксация времен удерживания, или RTL – Real Time Locking). Этот режим придуман в незапамятные времена (все-таки, ГХ 
существует более 80 лет), но – не так давно, с совершенствованием газовых регуляторов и технологий изготовления колонок – стал 
продвигаться известным Agilent. Доступны соответствующие библиотеки, хотя до известных токсикологических сборок (например, 
сделанных Maurer с соавт.) им, конечно же, очень далеко. Я не буду сравнивать эти режимы (тема весьма широка), но отмечу: тем, 
кто пользуется ФВУ ничего не мешает параллельно пользоваться также индексами. Хотя бы потому, что в вашем распоряжении будет 
вся обширнейшая информация, накопленная хроматографистами за все время существования ГХ (в том числе – приведенная в 
библиотеках NIST).



Начало работы.

Загружаем хроматограмму в AMDIS. Для этого есть 2 варианта:

1. Из обзорника (Spectrum-> AMDIS) 2. В самой AMDIS (File -> Open…)

и выбираем хроматограмму.
Это – каталог с расширением .D



И надо сделать важное действие. 
Оно выполняется однократно, после установки самой AMDIS (и только тогда, когда загружена 
любая хроматограмма).
Смысл его в том, что после обработки хроматограммы AMDIS создает отчеты – 2 файла с 
расширениями .ELU и .FIN и с именами, идентичными имени хроматограммы:

Они будут накапливаться в каталогах хроматограмм и мусорить. 
Если это нежелательно, то правим основные опции AMDIS.
File -> Options

и делаем так: 

Теперь AMDIS будет стирать отчеты при загрузке новой хроматограммы и при выходе.
А при следующем запуске будет автоматом загружать последнюю хроматограму.
Если эти отчеты зачем-то нужны, то пометьте Keep (сохранять) или Ask user (спросить). (Мне они не 
понадобились ни разу: проще обработать хроматограмму еще раз, это недолго, нежели 
вспоминать, при каких условиях создавались старые отчеты).



Поиск соединений по спектру (простой, Simple)

Если после предыдущего 
поиска параметры менять не 
надо (т.е. занимаемся 
рутинной работой), то после 
загрузки хроматограммы
просто Run

Если меняем параметры поиска 
(и/или библиотеку), то 
Analyze -> Analyze GC/MS Data…

Это вход в основное окно 
настроек, в нем придется 
бывать часто.
В Type of Analysis (а это 
выбор режимов работы 
AMDIS) выбираем Simple



Если надо, то выбираем 
поисковую библиотеку 
(Target Library)

Для этого жмем Select New… 
(выбрать новую).
Если надо просмотреть записи этой 
библиотеки, то View)



Ищем и выбираем требуемую 
библиотеку. 

О форматах библиотек 
(.MSP, .MSL – далее)

И подтверждаем выбор –
Save (это сохранит выбор 
для дальнейших работ), 
или отказываемся (Cancel)

Библиотеки, использованные 
ранее, можно выбирать из 
опускающегося списка (чтобы не 
разыскивать их на диске)



Далее выставим настройки; они одинаковы для всех режимов. Если они были выставлены 
ранее, это действие пропускаем.

Minimum match factor – это минимальный 
коэффициент совпадения (в данном случае – только по 
спектру, поскольку удерживание в этом режиме не 
учитывается!). Все найденные и предположительно
идентифицированные соединения, для которых эта 
величина получилась больше указанной, будут 
перечислены в списке  обнаружений.
Обычно рекомендуют величину 60. В подавляющем 
большинстве случаев этот выбор оптимален: список не 
будет слишком длинным из-за большого количества 
маловероятных (и, скорее всего, ложных) 
идентификаций . А действительно присутствующие 
вещества не будут пропущены.
У меня привычка указывать «40», т.к. это удобно для 
поиска новых (еще внесенных в поисковую 
библиотеку) соединений. И я привык к просмотру 
длинных списков.

Вкладка Identif (если вкладка не видна, 
работаем стрелками вверху справа).



Вкладка Instr (Инструмент). Правим 
ее содержимое при 
несоответствии рисунку.

Вкладка Deconv. (Деконволюция). 
Параметр Component width (ширина компонента) важен: это примерная 
ширина хроматографического пика на половине высоты, и он используется 
при интегрировании. Для скрининговых ГХ градиентов обычно 
выставляется 12. Однако  (редко) на сильно зашумленных  
хроматограммах AMDIS не может провести верное интегрирование и, 
следовательно, пропустит вещество. Если знаем, что оно на 
хроматограмме действительно присутствует, то этот параметр можно 
варьировать (обычно от 2 до 15).
Остальные параметры:  Adjacent peak subtraction (число мешающих ионов, 
используемых для поправок), Resolution (разрешение), Sensitivity
(чувствительность), Shape requirements (требования к форме) примерно 
описывают сложность хроматограммы – формы пиков и соэлюирование. 
На примере выставлен набор этих параметров, позволяющий добиваться 
высокой чувствительности при обнаружении. Как правило, менять их не 
надо; разве что Adjacent peak subtraction можно устанавливать в 2 (если 
знаем, что искомое вещество может присутствовать, но AMDIS его не 
видит).



Вкладку Libr. (Библиотеки) уже 
видели – она используется при 
подгрузке библиотек.

Вкладка QA/QC (Контроль качества). Здесь указываем 

вспомогательные параметры:
Solvent tailing («хвост» пика растворителя) – m/z иона, характеризующего 
растворитель вводимого образца (здесь  - этанол). Правильная установка 
требуется крайне редко: в случае, когда интересуют легкие соединения, 
выходящие на хвосте растворителя. Хотя на обычно используемой фазе 
(аналогичной 5% фенилметилполисилоксан) можно работать и с такими 
соединениями (конечно, весьма неуклюже), лучше взять другую 
колонку, более предназначенную для таких задач.
Column bleed (течь колонки) – m/z иона, характеризующего фон колонки 
– т.е., соединений, образующихся при термической деградации 
хроматографической фазы. Для обычно используемых фаз (HP-5ms, 
EVDX-5ms, DB-5ms, Rtx-5ms и прочих аналогичных 5% 
фенилметилполисилоксан) это 207 (фоновый спектр HP-5ms на 
следующем слайде)
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Остальные вкладки несущественны. Далее жмем Save (параметры будут записаны в 
инициализационный файл) и Run

Run – запуск обработки хроматограммы (та же, команда, что и на слайде  13). 

Время обработки определяется размером 
поисковой библиотеки, сложностью и длиной 
хроматограммы и, разумеется, компьютером. Так, 
долго обрабатываются хроматограммы
силилированных образцов (они весьма сложны).
Если при записи хроматограммы был убран (или 
сильно снижен) параметр Treshold (это порог 
шумов), то обработка будет очень долгой, хотя, 
иногда и более продуктивной).



ионные хроматограммы

профиль компонента

скан

библиотека

список

Рабочие окна AMDIS (так они названы в описании) 



Окна AMDIS можно убирать и восстанавливать (в зависимости от предпочтений и размера 
монитора.
Всего их 4 (неподвижных) и одно (список обнаруженных соединений) – перемещаемое.
Для этого: View -> Show Window… и правим пометки.

ионные хроматограммы
профиль компонента
скан
библиотека 



При первом запуске AMDIS окно-список 
фиксировано (и видно только тогда, когда 
включено окно Component Profile!!), см. 
предыдущий слайд. 

Его лучше сделать подвижным.
ПК по правому верхнему полю 
окна и выбираем Undock

Теперь его можно перетащить куда угодно. У 
окна 4 поля, а их размер меняем только со 
стороны каждого поля (в отличие от обычных 
окон Windows)



Содержимое любого окна растягиваем ЛК (это можно делать по ступеням, 
последовательно). Сброс растяжки – ПК и Unzoom (ступенчатый сброс) или Unzoom
All (полный сброс) 

В окне хроматограмм:

(треугольник, выбирается ЛК)– обнаруженные, но 
неидентифицированные соединения. В списке 
указываются их характеристики (для практики 
нужны редко).

(«т» - target, выбирается ЛК) –
соединения, для которых выполнена 
предположительная идентификация. 

Точно также соединения можно выбирать из списка.

Чтобы подсветить соединение, ПК по 
хроматограмме и выбираем Show 
Component on Chromatogram



При выборе соединения, для которого выполнена идентификация, индицируются спектры (их –
четыре)

При выборе неидентифицированного соединения, разумеется,  индицируются только 2 верхних спектра.
Посредством ПК (и далее выбор Nist Library -> Go to NIST MS Program) спектр можно переслать в оболочку NIST для 
опознания.
Белый пунктир – Uncertain (незначимые) ионы. AMDIS не уверена, что они действительно принадлежат 
очищенному спектру, и поэтому не обрабатывает их (хотя обращает внимание хроматографиста на их возможное 
наличие). Их можно показывать или спрятать (ПК по окну спектра и пометить или убрать пометку Show Uncertain 
Peaks). Эти ионы не пересылаются в NIST, хотя такую пересылку можно организовать, выбрав в основном окне 
AMDIS «Analyze -> Use Uncertain Peaks»

необработанный 
спектр в данной 
точке 
хроматограммы
(черный)

очищенный 
спектр в данной 
точке 
хроматограммы
(белый)

тот же, что и 
сверху  
(очищенный) 
спектр в данной 
точке 
хроматограммы
(белый)

спектр из 
библиотеки 
DRUGSCREEN 
(черный)



Ионы, составляющие спектр соединения, можно 
подсветить. Для этого: Options -> Select M/z…

И вписываем их в таблицу. Много 
– не надо, т.к. получится цветная 
мешанина.

Получится картинка:

белый – это всегда TIC

ионные хроматограммы. 
Чтобы оперативно их 
убирать, делаем ЛК по 
табличке.

область 
хроматографического
пика



Чтобы растянуть ионные хроматограммы по ординате (когда они плохо видны), выбираем 
Rescale – и они будут масштабированы по максимальной интенсивности:

Кнопка рядом (Info…) – это некоторая информация об обнаруженном соединении (из 
библиотеки) и о хроматограмме. Наиболее употребительна вкладка Setting (установки) –
там присутствует имя образца, задаваемое при запуске анализа (на случай, если забыли, 
что именно загрузили в AMDIS). 



Поиск соединений по спектру, используя индекс удерживания 
(Use Retention Index Data)

В окне Analyze GC/MS Data… (слайд 13) меняем тип анализа (Type of analysis) на 
Использование индексов удерживания (Use Retention Index Data)

Появится новый запрос – на таблицу RI 
Calib. Data… (данные калибровки 
индексов). Здесь надо выбрать и 
подставить файл с расширением .CAL –
собственно таблицу. Как он делается –
далее).

Кнопкой «RI Calib. Data…» вызываем окно установок и 
ищем на диске требуемую таблицу через Select New.. (то 
есть, так же, как и ранее – файл поисковой библиотеки). 
По нахождении – обязательно Save (при согласии с 
выбором) или Cancel – при отказе.
Через View эту таблицу (то есть, файл .CAL) можно 
просмотреть.



Все остальные настройки – те же, их не меняем.

Или – Run в основном окне AMDIS 
(если все настройки, включая 
библиотеку и таблицу) были 
заведены ранее, а мы только 
подгружаем очередную 
хроматограмму из обзорника при 
рутинной работе

Далее – Run (тут же, в окне 
Analyze GC/MS Data…). 

Совет. Не всегда надо обрабатывать всю 
хроматограмму. В окне хроматограммы можно 
выделить интересующую область и обработать 
только ее. 
Однако! AMDIS запоминает и выделение также! 
И при подгрузке новой хроматограммы в окне 
будет только ее часть (соответствующая 
выделенному ранее). Тогда – ПК по окну 
хроматограммы и выбираем Unzoom или 
Unzoom All.



Расконфигурируем окно-список.
Оно состоит из 4-х областей, а размер каждой из них можно менять ЛК за 
соответствующий угол. 

времена 
удерживания 

идентифицированные 
соединения

характеристики 
найденного 
вещества 

характеристики 
идентификации 
этого  вещества 



ПК по области времен удерживания –
возможность переслать очищенный 
спектр соединения в оболочку NIST для 
поиска по ее библиотекам (Go to NIST 
MS Program). Так можно переслать 
спектр любого найденного соединения 
– как того, которое AMDIS попыталась 
идентифицировать самостоятельно 
(как на этом рисунке), так и того, 
которое она идентифицировать не 
смогла (помеченные треугольниками 
сверху без «т»).
Или – можно закрепить окно-список 
(убрать галку Undock).

ПК по области идентифицированных 
соединений – возможность выбора между 
индикацией только лучших обнаружений 
(Best Hits Only), или же всех (и похуже, и 
получше – All Hits) для каждого соединения.
Что выбрать – дело вкуса, я предпочитаю 
Best.



ПК по области характеристик 
найденных веществ – это выбор 
индицируемых характеристик.

Выбираем View Options (показать 
опции). И настраиваем правый 
список примерно так:
Для нас главный смысл имеет 
величина RI – индекс удерживания. 
Ее перемещаем вверх. Остальное –
по желанию и степени знакомства с 
AMDIS (ширина пика, чистота, 
асимметрия, площадь, номер скана 
и.т.д. Это необязательные тонкости.)



Точно также с последней областью –
характеристик идентификатов.
Здесь наверх надо забросить
RI-RI(lib) – разница между индексом 
удерживания найденного соединения и 
библиотечным);
Net – показатель качества идентификации. 
Затем – Apply (Применить)

Величина Net выражена в 100-бальной шкале и – при поиске в режиме индексов удерживания – отражает сходство 
спектра и индекса удерживания найденного вещества и библиотечной записи. Это главный параметр качества 
идентификации. За отличия (спектра и RI) каждому идентифицируемому соединению начисляются штрафные очки. 
Способ (и величину) их начисления можно регулировать, но делать это рекомендуется по приобретению 
некоторого опыта.
Net=100 не бывает никогда (исключая случай, когда спектр вещества был взят именно из обрабатываемой 
хроматограммы.
При Net=80 и выше –хорошая идентификация.
При Net=70-79 – идентификация, вызывающая сомнение (в окне-списке перед названием соединения 
индицируется «?»).
При Net=60-69 – весьма сомнительная идентификация (индицируется «??»).
При Net=<60 – предполагаемая идентификация (индицируется «???»).
Важно!! Способ начисления штрафных очков по индексу удерживания довольно мягок (по ряду причин). Поэтому 
(кроме Net), следует обращать внимание на их погрешность (RI-RI(lib).
Для хорошо хроматографирующихся соединений (они обычно малополярны, а их пики почти симметричны  – это 
длинные фталаты, дериваты TMS, соединения с крупными алифатическими фрагментами и пр.) RI-RI(lib) обычно 
невелика ~ ±2.
Для полярных соединений с несимметричными пиками) – никотин, кофеин, фенобарбитал, недериватизированный
морфин, метаболиты анальгина и пр. RI-RI(lib) может быть ~ ±20 и более. Особенно, если соединения мало, а 
колонка грязная. 
Также RI-RI(lib) велика, если колонка перегружена по данному соединению. Вообще, все это – отдельная и 
объемная тема.



Отчет.
Вообще, AMDIS не обременена возможностями для печати вычурных отчетов. Однако, все необходимое 
есть. В каждой организации свои правила, я же могу лишь показать, как делал сам. 
В окне хроматограмм выделяем пик интересующего вещества и жмем Run. Возможно, эту процедуру 
придется сделать несколько раз. Цель – добиться того, чтобы в окне-списке фигурировало только одно –
требуемое соединение (поскольку распечатываться будет весь список).  

Выбираем File -> Print Text Report…



Помечаем Print Laboratory report  
и жмем Print Options…

И в представленном окне слева заносим свои 
реквизиты (это не обязательно).
Справа организуем Print order (порядок печати) как 
показано. Опять же – нам важны в основном, Net и 
RI-RI(lib), остальное – по вкусу. Затем – OK и Print. 
При этом распечатывается только текстовая 
информация.
Заполнять это окно надо только однократно (если, 
конечно, нет необходимости что-то менять). Если не 
надо – то сразу Print



Для распечатки графики выбираем File -> Print Spectra…
(я просто переворачивал лист и печатал на обратной стороне. 
Поскольку попадаются объекты, содержащие более десятка 
обнаружений – и соответственно, неподъемные отчеты.)

Помечаем требуемое.
Что именно – дело вкуса, 
мне хватает указанного.

ионные хроматограммы

профиль пика

скан (необработанный спектр на вершине 
пика)

экстрагированный спектр (очищенный 
спектр найденного вещества)

библиотечный спектр



Распечатывается примерно такой формат.
Это – лист обнаружения; он подкалывается к отчету.
Еще раз напоминаю: способ оформления отчета – это не руководство к действию (оно у 
каждого специфично), а только пример.

Здесь указана 
величина Net, 
измеренный индекс 
удерживания (RI) и его 
отличие от 
библиотечного (RI-
RI(lib))



Калибровка по алканам для работы с индексами удерживания

Нужны нормальные (неразветвленные) алканы. Где взять.

1. Поискать самостоятельно. Я собирал алкановые линейки от С8 до С32 – «из банок», причем С8-
С19 – все, а С20-С32 – только четные (такую смесь далее называю «легкие», ее растворяем в 
этилацетате). Этого числа может оказаться достаточно (удерживание холестерина около 3100 ед. RI). 
Обычно С8 и С9 не требуются, но если они есть, то не помешают. 
Более тяжелые алканы (С33 и далее) можно экстрагировать гексаном (их смесь далее называю 
«тяжелые»).
- Из пленки «Parafilm» – она применяется для запечатывания. Есть даже статья в серьезном журнале 
на эту тему.
- Из материала свечки. Не пробовал и не знаю, что получится.
- Из «вощеной» бумаги, применяемой ранее в аптеках (и теперь при упаковке, например, бинтов). 
Тоже не пробовал, но скорее всего, получится.
Экстракт надо надлежащим образом развести, тоже гексаном (в этилацетате растворяются хуже).
Иллюстрации далее основаны на сборке С8-С32 и экстракте «Parafilm».

2. Купить в Aldrich-Sigma (Fluka). Они продают прекрасную линейку С10-С40. Этого достаточно. Она 
зовется по каталогу: «68281 - Alkane standard mixture for performance tests of GC-systems. Analytical 
standard, C10 - C40 (all even), 50 mg/l each» (т.е. С10-С40, четные).

3. Попросить смеси у меня, они соответствуют по составу варианту 1. Постараюсь выслать и даже 
оплачу курьерку (если не слишком дорого).

Еще нужна поисковая специализированная (алкановая) библиотека. Это файл с расширением .CSL.
Где взять – дальше.
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T im e - ->

A b u n d a n c e

I o n   8 5 . 0 0  (8 4 . 7 0  t o  8 5 . 7 0 ) :  2 -3 0 8 2 7 _ 0 2 . D \ d a t a . m s

Колем алкановую смесь (здесь - С10-С32, т.е. «легкие»). Выглядит примерно так (в данном 
случае это не TIC, а ион m/z 85 – так нагляднее).

Важно! Смесь хроматографируем исключительно тем ГХ методом, который применяется при рутинном анализе – и в котором 
далее будем определять удерживание. Можно менять только настройки МС, но не ГХ. Алканы надо хроматографировать в 
режиме SCAN (стандартный диапазон – 45-550 m/z). Нельзя менять способ ввода (Splitless <-> Split), или менять делитель Split. 
Даже если это кажется удобным (поскольку не надо разводить слишком концентрированную смесь), но при этом меняются 
времена удерживания. А это недопустимо.
МС спектры алканов (примерно от С10 и тяжелее) почти одинаковы. А с увеличением их масс снижается интенсивность  
молекулярных ионов. Пытаться распознать их по спектрам (например, через NIST) непросто. И поэтому для их поиска на 
хроматограмме и нужна специализированная поисковая библиотека (файл .CSL) и специализированный режим их 
обнаружения. Чтобы не сбиться, просто считаем их (легкие до ~ C12 могут быть опознаны через NIST), или привыкаем к виду 
имеющейся смеси.  

С10 С32



Колонка не должна быть перегружена ни по одному из алканов . Когда составляется смесь, часто 
получаются перегруженные сигналы по более тяжелым компонентам (в районе С30). Это 
объясняется тем, что их содержание увеличивают, пытаясь получить интенсивные пики. Делать так 
не надо: пики более тяжелых алканов и должны быть менее интенсивны, нежели пики более 
легких. Концентрации должны быть таковы, чтобы AMDIS уверенно их опознавала (нередко 
бывает, что старшие алканы ~С28-С32 не опознаются; это не опасно).

это нормальный пик это перегрузка колонки – она обычно заметна 
по затяжке фронта. Надо разводить.

Сказанное относится не только к алканам, а к ГХ в целом.
В практическом же плане (при рутинном анализе) образец обычно нет необходимости 
разводить, даже если интересующего вещества слишком много. Просто следует учесть, что при 
этом несколько вырастет его индекс удерживания из-за асимметрии пика.
Однако, алканы при калибровке должны быть хроматографированы оптимально, поскольку на 
этих данных будет основано множество последующих измерений.



Пересылаем хроматограмму в AMDIS.
Меняем режим обработки. 

в «Type of analysis» выбираем «RI 
Calibration/Performance» (калибровка времен по 
индексам удерживания)

в Calib/Stds. Lib… указываем алкановую поисковую 
библиотеку (файл с расширением .CSL)

в RI Calib. Data… указываем имя будущего 
калибровочного файла. Совет: лучше составлять имя 
этого файла из имени метода измерения и из даты 
калибровки (дата-месяц). 

Далее – Run (когда появляется окно предупреждения –
соглашаемся).



По окончании работы (а это быстро) можно пройти по списку и проверить правильность опознания. Оно не 
должно вызывать сомнений у AMDIS, т.е. без знаков «?» перед именами. Повторяю: если содержимое 
поисковой алкановой библиотеки (.CSL) не соответствует алканам, присутствующим на хроматограмме, то 
AMDIS с большой вероятностью собьется. Это происходит по уже упомянутым причинам: спектры алканов
очень похожи, и в данном поисковом режиме (RI Calibration/Performance) AMDIS ищет их по порядку списка в 
поисковой библиотеке. 

Часто бывает, что самые тяжелые алканы тем не менее, 
не опознаются (здесь не распознан последний – С32).
Тогда впишем их в калибровочный файл руками. А его 
время удерживания – 13.043 мин. – учтем.



Вот получившийся калибровочный файл. 
Это просто таблица; в дальнейшем AMDIS
использует ее для пересчета времен 
удерживания в индексы. Для каждого 
алкана указаны: 

время 
удерживания

его индекс

величина Net отношение 
сигнал/шум 
(S/N)

название

Для AMDIS в этой таблице нужны только 
пара чисел для каждого алкана: время и 
индекс.
Поэтому копируем последнюю (или любую 
другую) строчку и вставляем ее в конец:

В добавленной строчке меняем время 
(13.043) и индекс (3200). Желательно также 
название (но это уже для себя, т.к. AMDIS с 
ним не работает).

После чего сохраняем и работаем с ним в 
основном поисковом режиме AMDIS – Use 
Retention Index Data.



Смесь «тяжелых» алканов (из Parafilm-а, «вощеной» бумаги, м.б. свечки и пр.). Ее надо колоть для калибровки, 
если интересуют соединения с индексами > 3200. Режим регистрации МС – обязательно – должен быть SIM по 
3-м ионам (можно и больше, но не нужно): m/z 57, 71, 85. Это наиболее интенсивные алкановые ионы.
А вид этой хроматограммы отвечает на вопрос о том, почему нельзя было смешивать две алкановых смеси. И –
зачем пользоваться режимом SIM.
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Abundanc e

T IC: 2-30827_03.D \ data.ms

легких 
алканов
почти 
нет

эти нас не интересуют –
мы их уже занесли в 
калибровочный файл. И –
их слишком много, 
возможен перегруз 
колонки по ним

а это – область 
нашего внимания. 
Однако, их слишком 
мало, они почти не 
видны, поэтому -
SIM
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I o n   8 5 . 0 0  (8 4 . 7 0  t o  8 5 . 7 0 ) :  2 -3 0 8 2 7 _ 0 2 . D \ d a t a . m s
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Наложим две смеси по m/z 85:

легкие

тяжелые

алкан С32

а это, соответственно, С32, С34, С35
(в самостоятельно готовленных смесях есть как четные, так и нечетные)

Остальные же видны при растяжке. Их мало.



Хроматограмму смеси «тяжелых» не отправляем в AMDIS: это бессмысленно из-за 
регистрации в режиме SIM. Времена удерживания берем из обзорника. Далее правим 
калибровочный файл так же, как на слайде 43. Крайне желательно не ошибиться: в этом 
случае измеряемые индексы будут искажены, а никакой «дуракозащиты» (foolproof) в этой 
области у AMDIS нет (вообще-то, и быть не может).

Важно! Настоятельно не рекомендую увеличивать концентрацию раствора «тяжелых» 
алканов сверх необходимого:  т.е. сверх того, когда их пики уже видны (примерно как на 
предыдущем слайде) и их удерживание можно измерить. Иначе – есть риск 
преждевременно запачкать колонку. Кстати, это замечание относится далеко не только к 
алканам – а к любым сверхконцентрированным образцам. Если вещество не присутствует 
на хроматограмме ( и вколотый образец кажется «чистым»), то это отнюдь не основание 
для подобной уверенности! Из любой хроматографической колонки выходит гораздо 
меньше того, что в нее введено. Огромное количество загрязнителей навсегда останутся на 
начальном участке колонки: это тяжелые соединения, жиры, высокополярные соединения 
(углеводы), разнообразные полимеры. Кстати, в экстракте растительного материала 
(«травке»), как правило, много растительных гликозидов. И они не хроматографируются
методом ГХ. Не следует впоследствии удивляться факту преждевременной кончины 
колонки после казалось бы, «пустых» хроматограмм.
Кстати, одна из причин большей живучести колонок, на которых разделяют TMS-дериваты –
это ситуация, когда то, что могло бы навсегда остаться в колонке, покинет ее в виде 
деривата TMS. А «сложным» и «грязным» TMS-образец кажется лишь потому, что состав 
введенной в колонку смеси гораздо более соответствует тому, что из нее выходит.



ГХ-МС библиотеки

Их очень условно их можно разделить на:
- общего назначения (например, NIST, WILEYREGISTRY, Palisade и пр.);
- и тематические (токсикологические, экологические, пестицидные и пр.); для нас особенно важна токсикологическая 
библиотека,  созданная группой Maurer (в пиратских копиях под разными названиями: PMW Tox, MPW Tox, Tox base и пр., ее 
последняя официальная версия - MPW2011). Она содержит спектры и индексы удерживания нативов, метаболитов и артефактов, 
а также их дериватов – ацетатов, перфторацетатов, алкилсиликатов, метилатов.

И на:
- используемые в качестве баз (та же NIST);
- поисковые (в том числе MPW), используемые AMDIS. Чем больше поисковая библиотека, тем больше время обработки 
хроматограмм (при – нередко – сомнительных преимуществах). Поэтому использовать NIST в качестве поисковой – неудобно.

Объем библиотеки ничего не говорит о ее качестве.  
NIST – наиболее авторитетная и очень тщательно подобранная библиотека, но она содержит огромное количество веществ, 
которые мы не увидим никогда и которые нам совершенно не интересны. С другой же стороны, интересующая нас область в ней 
представлена слабо (нативы в каком-то количестве присутствуют, но вот метаболитов и дериватов почти нет).
WILEYREGISTRY и Palisade более объемны, нежели NIST; однако, это превышение объема достигнуто откровенно сомнительными 
спектрами и просто мусором. Тем не менее, они иногда бывают полезны при поисковых работах, помогая определиться с 
характером неизвестных структур.
Множество небольших библиотек выложено в сеть. К их содержимому следует относиться с большой осторожностью.

Не бывает безошибочных библиотек, если они хоть сколько-то объемны (поскольку их составляют люди).

Библиотеки существуют в разных форматах, причем конверсия нередко затруднена. Производители оборудования создают свои 
форматы (бывает – почти полностью закрытые) и стремятся теми или иными способами (подчас просто смешными) ограничить 
возможности их конверсии. В последнее время эта ситуация только ухудшается, и это – мировая тенденция, и иначе не будет.
Для нас наиболее важны форматы .MSP (это открытый и простейший формат) и NIST (его трудно назвать полностью открытым, 
хотя он штатно - и обратимо – конверсируется в открытый .MSP).



NIST. То, что на картинке – не библиотека. Это – оболочка (поисковая, справочная, расчетная и пр.), 

позволяющая работать с библиотеками ряда форматов, и – в первую очередь, с форматами NIST и .MSP. У 
оболочки 6 вкладок (внизу). На картине выбрана вкладка Lib. Search (библиотечный поиск) и предназначена 
она для автоматического поиска спектров, подобных поступившим извне (из обзорников, из AMDIS или из 
отдельных файлов, содержащих спектры).

перечисление 
источников 
входящих 
спектров

список 
веществ, 
найденных в 
библиотеках 
(в порядке 
убывания 
степени 
сходства их 
спектров с 
входящим 
спектром)

то же, в 
графическом 
варианте

входящий 
спектр и его 
реквизиты

вещество, найденное 
в библиотеках и его 
реквизиты, согласно 
списку

визуальное сравнение входящего спектра и спектра вещества, 
найденного в библиотеках. Спектры можно накладывать, 
располагать зеркально, вычитать – кому как удобно.



А чтобы выбрать библиотеки, по которым будет проводиться поиск, выбираем Options -> Library 
Search Options

Слева окне Library Search Options – имеющиеся 
библиотеки. Переносим из левой части в правую 
требуемые или убираем оттуда ненужные (это делается 
кнопкой «Х», причем библиотека при этом не стирается, 
а лишь выводится из процедуры поиска в настоящий 
момент).

В комплект NIST (говорю только о версии NIST11) входят:
mainlib – основная библиотека;
replib – библиотека реплик – спектров веществ, уже 
имеющихся в mainlib, но снятых в несколько иных условиях (и 
несколько отличающихся); 
nist ri – библиотека индексов удерживания тех веществ, 
спектры которых отсутствуют в mainlib;

nist msms
nist msms2 – спектры МС/МС, к нашей тематике не относятся.

В списке на картинке также имеются.

Сторонние платные библиотеки (не входят в комплект NIST):
mpw2011 – токсикологическая библиотека Maurer;
wileyregistry8e-n05 – составная библиотека издательства Wiley
и NIST.

cann_metab – собственные библиотеки.



Сами же библиотеки формата NIST находятся в каталоге NIST (имя основного каталога-
расположения может быть другим)- MSSEARCH

Каждая из них – каталог с неким набором файлов. Если откуда-либо была получена сторонняя библиотека в 
формате NIST, то ее (в виде такого же каталога) надо просто откопировать в каталог MSSEARCH, после чего 
перезапустить оболочку. И она появится в списках Library Search Options. Есть ограничение по количеству 
библиотек, с которыми работает оболочка; при затруднениях надо просто убрать наименее потребную 
библиотеку из каталога MSSEARCH.



Если список Included Libs (то есть список библиотек, предназначенных для поиска) 
изменен, то выбираем OK. И повторяем поиск: в основном окне – Go. Поиск будет 
повторен с новыми условиями.
Остальные настройки в окне Library Search Options – для опытных пользователей. Те, 
что выставлены по умолчанию, как правило, пригодны для большинства задач. 

В данном примере в оболочку NIST поступил спектр триметилсилилированного ибупрофена из AMDIS.
Основной показатель результатов поиска – параметр Match (совпадение), по 1000-бальной шкале. Найденные вещества 
располагаются по убыванию Match. Считается, что при величине Match:
более 900 – прекрасная идентификация;
800-900 – хорошая;
700-800 – сомнительная;
менее 600 – весьма недостоверная.
Однако, для верных заключений одного параметра Match недостаточно. Например, входящий спектр очень беден: у него 2-3 (а то и 
один) интенсивных иона. Такие спектры случаются у соединений с третичным алифатическим азотом (производные PVP, 
фенэтиламины). Тогда Match может быть высоким, а идентификация – на деле – сомнительна. Или другой пример: соединения с 
объемными алифатическими фрагментами (те же алканы, стероиды), дающие богатые, но малоспецифичные спектры. И поэтому.
Важно! Масс-спектр весьма (но далеко не абсолютно) специфичная характеристика вещества. Посему достаточно веществ, 
обладающих весьма похожими спектрами. Чтобы помочь сделать верное заключение, оболочкой рассчитываются дополнительные 
параметры – и, в первую очередь, Prob. (%). Он отражает степень сходства спектров соединений со смежными Match. Рассмотрим 
типичную ситуацию.

В данном примере найдены 3 библиотечные записи, спектры в которых наиболее соответствуют входящему спектру – веществу, 
обнаруженному  AMDIS. Это «Benzeneacetic acid, α-methyl-4-(2-methylpropyl)-, trimethylsilyl ester», найденный в двух библиотеках NIST 
(M – mainlib, основная и R – replib, реплики) и «Ibuprofen TMS P638» - в библиотеке mpw2011. Это одно и то же вещество, однако, 
разница в библиотечных спектрах привела и к разнице Match.



Если параметр Prob. (%) резко снижается для смежных записей в списке (84.5 - 14.7 - 84.5 - 0.48 и далее почти столь же малый), то 
это говорит о том, что первые три спектра кардинально отличны от последующих. Это хорошо, поскольку получается, что спектр 
силилированного ибупрофена действительно высокоспецифичен, а значит, идентификация (вкупе с высоким Match ) весьма 
достоверна . А если бы параметр Prob. (%) снижался плавно – при движении вниз по таблице - или был бы почти постоянным, то 
такое его поведение свидетельствовало бы о малой специфичности его спектра, о наличии значительного числа соединений с 
похожими спектрами и, следовательно – о ненадежности идентификации. Даже если параметр Match был высок.
Из этой иллюстрации видно, что спектры одного и того же вещества, приведенные в разных библиотеках – несколько различны, а 
параметр Match не является строгим (действительно – для данного примера он меняется как 804 – 743 – 708), а ведь это одно и то 
же соединение!
Отсюда, и еще раз. Поиск «по спектрам» недостаточен; надо знать удерживание – причем, с максимально возможной точностью.

Важно! Характеристики качества идентификации – Net в AMDIS, Match в NIST и прочие в подобных программах – не являются 
строгими в математическом смысле. Они вычисляются на основании множества чисто эмпирических предположений, и – кроме 
того – зависят от настроек. А сами «эмпирические предположения» формировались создателями софта на основании 
обширнейшего экспериментального материала. Те из них, которые приводили к минимуму ложных – и к максимуму истинных 
идентификаций – и использованы в программах. Поэтому сравнивать параметры идентификации можно только в качественном 
плане.

Остальные вкладки.

Other Search – для поиска веществ в библиотеках по номинальной и 
точной массам, брутто-формулам CAS#-номеру и пр. Библиотеки 
для поиска выбираются в появляющемся окне опций поиска

Names – поиск по названию соединения. 
Библиотека выбирается из открывающегося списка 
тут же.



Каждая запись в библиотеках, открытых 
оболочкой NIST и включающих структурную 
формулу, содержит расчетный индекс 
удерживания. Это – лишь оценочное значение, 
и оно наиболее близко к индексам, 
получаемым на слабополярных фазах (типа DB-
1, HP-1) при пологих градиентах и в 
изократике. Учитывая «оценочный характер», 
этот индекс пригоден и для ориентировки по 
удерживанию на распространенных фазах 
(аналогичных 5% метилсилоксан)

Многие записи библиотеки NIST (и только ее) 
содержат данные об экспериментально 
измеренных индексах. Пользуясь ими, надо 
обращать особое внимание на тип фазы!
Для нас наиболее пригодны слабополярные
метилфенилсилоксановые. 



Вкладка Compare – для визуального 
сравнения любых спектров.

Спектры пересылаются в ее 
окна посредством ПК по 
строке в любом списке и 
выборе Send to -> Compare 
List

спектр, принятый извне

спектры трех наиболее вероятных (по 
параметру Match) библиотечных 
соединений

область сравнения; можно выбрать способ (Difference –
вычитание и отзеркаливание, Head to Tail – отзеркаливание, 
Side by Side – расположение рядом, Subtraction – вычитание)



Вкладка Librarian – для редактирования библиотек. Здесь можно создавать и 
редактировать библиотеки в форматах NIST и .MSP. Библиотеки, входящие в 
комплект NIST (mainlib и пр.) не редактируются – в этом плане они закрыты.

Спектр пересылается во вкладку так же, как это показано на предыдущем 
слайде при выборе Send to -> Spec List.

Спектр(ы) – или содержащие их библиотечные записи - можно загрузить 
во вкладку из сторонних библиотек (с диска) в формате .MSP

или из библиотек в формате NIST

и записать (на диск) в формате . MSP

Библиотечные записи (и спектры, 
разумеется) можно редактировать

Сей процесс выполняется в этом окне. Его детали описывать 
в этом руководстве не буду, но – если они интересны, то 
напишу отдельное. Впрочем, процесс редактирования прост 
и «интуитивно понятен».

Остальные кнопки – для создания и 
редактирования библиотек в формате NIST.

Кстати, убрать ненужный спектр из вкладки можно просто с 
клавиатуры (Delete). При этом спектр удаляется только из 
вкладки – но не из библиотек (если он там находился).



Формат .MSP и работа с ним - подробнее. Это простейший формат, используемый для создания поисковых 

библиотек AMDIS и применяемый также для обмена спектров между библиотеками разных форматов. Библиотека в формате 
.MSP может состоять из одной записи, или из многих.  Редактирование может выполняться любым софтом, работающем с 
простыми текстовыми (или ASCII) файлами (например, WordPad или Блокнот). Однако, для редактирования рекомендуется 
пользоваться соответствующим  софтом (NIST – на предыдущем слайде) или AMDIS (далее). Смысл этой рекомендации в том, что 
любая синтаксическая ошибка при редактировании (как это утверждают создатели AMDIS) может привести к непредсказуемым 
последствиям .

Это две записи в формате .MSP – для двух веществ (амфетамин и его ацетилированный дериват).

Каждая запись включает только 3 обязательных поля:
название вещества

число ионов в спектре
и сам масс-спектр.

Спектр записан в виде пары чисел для каждого иона: его m/z 
и его относительная интенсивность (от 1 до 1000). Так, 
наиболее интенсивный ион в данном спектре амфетамина –
m/z 91. Вообще-то, в спектре амфетамина есть и более 
интенсивный ион – m/z 44. Но спектр, приведенный здесь, не 
содержит ионов с m/z меньше 50 (и это понятно, поскольку 
диапазон SCAN удобно ограничивать m/z 45, ниже находятся 
ионы остаточных газов, всегда присутствующих в камере 
спектрометра и создающих его фон; m/z 44 соответствует 
углекислоте).

Остальные поля – факультативны. Они могут распознаваться 
каким-либо софтом или - если не распознаны - то 
игнорируются им. Важным полем является индекс 
удерживания (RI) – с ним работает AMDIS.

Формально библиотека .MSP не ограничена числом записей: 
она может быть одна или сколь угодно много. Однако, софт, 
работающий со слишком длинной библиотекой, может 
сбоить.

Записи в .MSP- библиотеке разделяются пустой строкой.



С библиотеками формата .MSP можно работать в оболочке NIST (вкладка Librarian, слайд 48), или 
непосредственно (предыдущий слайд). Однако, наиболее удобный способ – инструменты AMDIS. Для этого в 
окне AMDIS выбираем Library -> Build One Library или Library Transfer (первый вариант удобнее при 
редактировании одной библиотеки, второй – при переносе записей из одной в другую).

Получаем окно редактора. В него уже загружена библиотека, с которой работали ранее.

Если надо, загружаем другую библиотеку 
(Files… -> Load Library).
Важно! При загрузке учитываем 
расширение имени файла – т.е. .MSP. 
AMDIS также работает с форматом .MSL
(он очень похож), но я его не 
рассматриваю и пользоваться не советую, 
т.к. при работе с большими библиотеками 
.MSL случаются неприятные сбои.

или выходим из редактора

Так записи стирают.
Важно! Редактор выполняет команды «сразу» – без 
подтверждений. Стертую запись уже не восстановить –
придется брать резервную копию библиотеки. Однако, 
именно так работают и многие другие редакторы. 

Это – редактирование записи. 

текстовое содержимое записи 
если здесь выбрать «Spectrum», то он 
будет индицироваться внизу окна –
это удобно.



То же окно – вместе со 
спектром.

редактирование спектра. Вряд 
ли это понадобиться – разве что 
стереть очевидную грязь.  

название соединения

его брутто-формула

и индекс удерживанияесли известен CAS# - номер, то его можно 
вписать. Кстати, NIST распознает 
соединения именно по CAS# - его 
универсальному международному 
идентификатору (а не по названию)

После окончания 
редактирования –
обязательно Save (если 
все устраивает) или 
Cancel – отказ.

комментарий – не 
обязателен, но удобен



Если есть потребность в переносе записей (или спектров) из одной библиотеки в другую, или в занесении 
одного спектра (записи) в уже имеющуюся библиотеку – то есть, формирование и пополнение библиотек, то 
окне AMDIS выбираем Library -> Library Transfer. Теперь индицируются окно, состоящее из двух половин, и они 
неравноценны: слева библиотека-источник, справа – назначение. Копирование слева направо – Transfer->.

источник назначение

загружаем библиотеки 
кнопкой Files… Появится окно:  

загрузить библиотеки в левую (будущий 
источник) и правую (будущее 
назначение) части  

если библиотеки-назначения еще нет (т.е. ее только 
начали собирать), то справа выбираем Create New 
Library (создать), и указываем имя новой 
библиотеки.
Save Library As… - сохранение библиотеки под 
другим (нежели изначальное) именем. Пользоваться 
этой командой не обязательно: библиотеку можно 
переименовать штатными средствами Windows.



Если на хроматограмме найдено некое соединение, которое хотелось бы поместить в 
поисковую библиотеку.

Помечаем его (в окне 
хроматограмм или окне-списке) и 
выбираем File -> Save Component 
MS…

… и сохраняем как файл .MSP

после чего работаем с ним так, как это 
описано на предыдущих слайдах.



Или – упрощенный вариант. Пометив соединение, вызываем окно редактора (Library -> Build One Library) и 
выбираем Add:

После добавления спектра в библиотеку, ее придется редактировать (указать имя соединения и пр.). Этим –
упрощенным – способом я не пользуюсь: полагаю, что удобнее хранить спектры найденных соединений 
отдельно (т.е. как .MSP – файлы, содержащие единственный спектр), и уже впоследствии решать их судьбу.

Следует учесть: есть более сложный и более надежный способ получения очищенных спектров для 
библиотеки; он реализуется ручными (неавтоматическими) процедурами. Однако, им можно пользоваться 
после получения некоторого опыта.



То есть, процедура формирования библиотек сводится к.
1. Обнаружению некоего соединения с помощью AMDIS.
2. Сохранению его спектра в виде .MSP-файла (средствами AMDIS).
3. Добавлению этого спектра в уже имеющуюся поисковую библиотеку и процедура 
редактирования (указание названия соединения, индекса удерживания и пр.).

Несколько советов по работе с библиотеками.
1. Эта деятельность требует аккуратности, педантичности, а также некоторого занудства. Обязательна здоровая 
подозрительность. А стиль работы вроде «вписывай побыстрее, потом разберемся, а то времени нет, а отчет 
уже вчера требовали (варианты: на телефоне висят, в коридоре ждут и пр.) очень быстро приводит к обретению 
совершенно невразумительного «вороньего гнезда», разобраться в котором впоследствии будет совершенно 
невозможно. И будет немалым везением, если все это не закончится ложноположительными.
2. Библиотека, полученная откуда-либо, обязательно должна иметь исходную копию.
3. Дополняя библиотеку, необходимо вести учет. Удобнее всего это делать в Excel, в виде сортируемых таблиц. В 
таблицу можно писать название, брутто-формулу, молекулярный вес, удерживание. Очень желательно 
название хроматограммы, из которой взят спектр. И, конечно, какие-либо неформальные пометки – для себя.
4. Спектр, принимаемый в библиотеку, должен быть максимально корректен. В идеале, образец следует колоть 
дважды, разными градиентами (побыстрее и помедленнее), после чего сравнивать 2 полученных спектра. 
Кстати, при таком сравнении обычно видны «чужие» ионы, и это не удивительно: ведь матрица биообразцов
очень богата, и вытаскивать из хроматограммы абсолютно чистые спектры получается не всегда.
5. Как уже говорилось, сколько-то крупные библиотеки не бывают безошибочны. Один из распространенных 
случаев – плохое соответствие библиотечного и получаемого спектров (пример – парацетамол в библиотеке 
MPW2011). Это значит, что параметр совпадения (Net) будет невысоким. Эту особенность можно запомнить и –
в дальнейшем – иметь в виду, а можно записать спектр неудачного соединения самостоятельно и занести в 
поисковую библиотеку . MSP (кстати, старый спектр стирать не обязательно – опознание пройдет по наиболее 
похожему).
6. Если нет уверенности в обнаруживаемом веществе, то лучше посоветоваться с более опытными коллегами. И 
если надежных советников не нашлось, то считать образец отрицательным. И дело, как мы все прекрасно 
понимаем, конечно же, совсем не только в букве закона, требующего трактовать сомнения в пользу 
подозреваемого. 



Специализированная (алкановая) поисковая библиотека (файл .CSL). 

Несмотря на то, что она хранится 
как файл с расширением .CSL, ее 
формат почти соответствует 
формату поисковых библиотек 
(.MSP).

Ее можно сделать самостоятельно 
вытяжками из библиотеки NIST (это 
далее).
Можно взять мою (или – я сделаю 
требуемую и пришлю). 
Однако, есть жесткое требование: 
она должна содержать данные 
только тех алканов, которые 
действительно содержатся в смеси. 
Значит, желательно уметь ее 
редактировать. 
Редактирование – так же, как и для 
.MSP выполняется любым софтом, 
работающем с простыми 
текстовыми (или ASCII) файлами 
(например, WordPad или Блокнот).

название алкана

брутто-формула

индекс удерживания

метка использования 
алкана для 
калибровки

число ионов в спектре

спектр

обязательные поля:

и – пустая строка 
между записями



«Вытяжки» из библиотеки NIST (или другой). 
Этот способ пригоден не только для алканов; точно так же можно забирать спектры любых 
соединений для последующего использования в поисковых библиотеках AMDIS (файлах .MSP)

Во вкладке Names оболочки NIST выбираем библиотеку 
(пусть mainlib – основная из набора NIST) и вещество (пусть 
декан). Затем по нему ПК и выбираем Export Selected – и 
тогда запись (а точнее, часть записи) Decane будет сохранена 
в виде файла .MSP, содержащего только один спектр.

Записываем имя и указываем путь. В 
поле «Тип файла» должен быть указан, 
разумеется, .MSP.



Теперь надо считать полученный 
C10.MSP в AMDIS. 
В окне AMDIS выбираем Library -> Library 
Transfer

В окне редактора выбираем Files…

В появившемся окне – на его левой 
половине «Source» (Источник) выбираем 
«Load Library…» (Загрузить библиотеку)



обязательно указываем расширение - .MSP ( AMDIS по 
умолчанию выставляет .MSL) – и Открыть.

на правой половине окна выбора файлов 
«Destination» (Назначение) выбираем:
«Load Library…» (Загрузить библиотеку) – если некая 
библиотека уже есть, а мы собираемся ее пополнить 
спектром декана;
«Create New Library…» - если создаем новую 
библиотеку.

в поле «Тип файла» обязательно указываем 
расширение - .CSL, записываем имя (пусть 
alcanes.csl) – и OK.



и в окне выбора файлов выбираем «Close».

Теперь в левой части окна – библиотека с 
характеристиками декана, справа – будущая (и пока 
пустая) библиотека alcanes.csl. Помечаем Decane и 
выбираем Transfer.



Теперь характеристики декана записаны в  
библиотеку alcanes.csl. Помечаем Decane справа и 
выбираем Edit…

В окне редактора записи дописываем только индекс 
удерживания декана – 1000. И – Save.



В появившемся окне обязательно надо пометить «Use 
for RI calibration» (Использовать для калибровки по 
индексам) - и OK.
Далее, действия – от слайда 64 - повторяем до 
заполнения библиотеки.

Теперь, если ее загрузить в редактор AMDIS
посредством Library -> Build One Library (или Library 
Transfer), то она выглядит примерно так. Перед 
каждым названием алкана – символы c#.



Если мы просто собираем поисковую библиотеку для AMDIS из ресурсов NIST (или другой 
библиотеки в формате NIST), то удобно еще пользоваться таким путем. После выбора 
приглянувшегося соединения (ПК по названию) выбираем Send To -> Spec List

и редактируем его запись во 
вкладке Librarian оболочки 
NIST

после чего сохраняем как .MSP и считываем 
редактором AMDIS. Этот путь удобен, если есть 
желание сохранять уже отредактированные 
записи.

Описанный способ формирования библиотек – не единственный, а выбор способов –
дело вкуса и потребностей. 



Еще раз, по форматам файлов, используемым AMDIS:

.MSP – поисковая (Target) библиотека (может состоять из одной или многих записей); 

.CSL – специализированная алкановая поисковая библиотека;

.CAL – таблица пересчета времен удерживания в индексы.

В заключение – несколько советов.
1. Об измерении времен удерживания алканов.
Первый (после некоторого перерыва) вкол обычно неудачен: времена удерживания несколько 
сдвинуты. Поэтому алканы рекомендуется колоть после холостого прокола. Также рекомендуется 
колоть их дважды для контроля воспроизводимости времен. Для проверки накладываем 
полученные хроматограммы в обзорнике; удерживание на нормально работающем хроматографе 
должно практически совпадать. Если это не так, то колем в третий раз и снова смотрим. При 
неудаче придется разбираться с работоспособностью хроматографа: с ним работать нельзя.
Если растворы алканов существуют в виде двух смесей (как в приведенных примерах), то «легкие» 
колем так, как описано выше, а «тяжелые» – однократно и убеждаемся в совпадении (или малом 
отличии) времен удерживания алкана С32.
Необходимость (периодичность) проведения калибровок определяется ситуацией. После смены 
(или обрезки) колонки – обязательно. В течение времени ее жизни хватает периода ~ 2 недели 
(при старении колонки времена удерживания несколько снижаются). Также придется колоть 
алканы, если появились сомнения в работоспособности колонки. Резкое изменение времен 
удерживания говорит о неприятностях у ГХ. «Размывание пиков» алканов и затяжка тыла 
(особенно ~ С28 и тяжелее) намекает на то, что колонка загрязнена; ее надо менять или подрезать, 
поскольку элюирование целевых – более полярных соединений – будет проходить еще хуже.



2. Грамотно составленные поисковые библиотеки, как правило, содержат характеристики не 
только интересующих нас соединений, но и многих других: матричных компонентов (жирные и 
ароматические кислоты, некоторые биогенные амины, стероиды и пр.), типичных загрязнителей 
(фталаты, артефакты четвертичных аммониевых оснований), компонентов пробоподготовки – т.е. 
фоновых соединений. Они сами (или их дериваты) удобны для оперативного контроля процесса 
регистрации хроматограммы, поскольку позволяют следить за удерживанием – на протяжении 
всей хроматограммы. Их опознание библиотекой сберегает время, затрачиваемое на обработку 
вопросов типа «а это что за огромный пик?...»
И - об одном удобном приеме. Когда ко мне попадает чужая хроматограмма, то эти соединения 
помогают сориентироваться в удерживании. Ведь в таблицу .CAL (слайд 43) можно вписать 
времена-индексы не только алканов, а любых соединений, индекс удерживания которых (хотя бы 
приблизительно) известен. Ищем фоновые соединения на всей хроматограмме (или на 
интересующем участке) в режиме Simple, составляем из них таблицу .CAL (вручную, разумеется) и 
повторно обрабатываем хроматограмму с полученной таблицей. Конечно же, этот подход –
приблизительный, но обычно вполне достаточный для уверенных заключений.

3. При сбое (зависании AMDIS) просто запустите (закройте и запустите) ее снова. Поскольку при 
аварийном завершении работы файлы отчетов (.ELU и .FIN) сохранятся (AMDIS стирает их при 
штатном закрывании), то результаты обработки последней хроматограммы сохранятся также. 
Вообще, сбои AMDIS – большая редкость.

4. AMDIS высоко совместима с Windows. Проверено от Win2000 до Win7, любой разрядности (х86, 
х64) и любой локализации (eng, rus). Поэтому (при наличии затруднений) следует искать решение 
в другой области (антивирус, прочие резидентные программы, неверная установка – хотя это, 
пожалуй, нереально).



5. Если AMDIS не нашла вещество на хроматограмме:
- снизьте параметр Minimum Match Factor в окне настроек хотя бы до 20 (или ниже) и проведите 
поиск снова (для экономии времени – на ограниченном участке хроматограммы). Скорее всего, 
имеет место несоответствие между очищенным и библиотечным спектром. Подсветите ионы 
искомого соединения (возьмите их из NIST, лучше – более тяжелые и интенсивные). Или –
случилось несоответствие удерживания из-за какой-то ошибки. Повторите поиск в режиме Simple 
(без учета удерживания).
- возможно, случилось неустранимое наложение. В этом легко убедиться, просматривая 
интенсивные ионы в области удерживания искомого соединения. Тогда придется менять условия 
ГХ, перекалывать, или очищать образец.
- колонка загрязнена, а искомое вещество полярное, его мало и его пик чрезвычайно затянут по 
тылу (получилась «пологая возвышенность» на пол-хроматограммы, а не пик). Подсветите его 
ионы, убедитесь, что это так, снизьте (и вообще поменяйте) параметр Component width в окне 
настроек. Если не выйдет – придется колоть более концентрированный образец или сменить 
(подрезать) колонку. Разумеется, искомое соединение следует дериватизировать (если 
возможно).
- а может, его там попросту нет (на хроматограмме или в библиотеке)?

На этом пока все – и спасибо за внимание.


